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e Version 0.61 released on June 12, 2008.

— Note Taker Additons/Changes/Bugs
* Added the menu item Clue which allows the user to add information about
any clues that are found.

* Added the menu item IAP which allows the user to add text versions of the
Incident Action Plan ICS forms (202-206).

* Moved the Insert menu item (and the items below it) from under Tools to
the main menu.

* Made the Tab key operate the same way as completing forms, namely, takes
you to the end of the following line. The Esc key takes you to the end of the
previous line (easier to use than Shift Tab).

* Whenever text is inserted from a menu item at the position of the cursor,
the cursor is returned to this initial point. This together with the Tab key
allows you to rapidly go from one item to the next.

x Corrected an occasional problem under Spell Check, when the dictionary
could not be found.

— Access Forms Additions

* Added ICS forms 202-206 in both Word and pdf format.

x Added two pdf documents, Clue Log and Clue report, courtesy of the Bay
Area Search and Rescue Council (www.basarc.org).

— Corrections
x Corrected various cosmetic problems resulting from introducing the Military

Time option.

e Version 0.60 released privately on June 6, 2008 for an 8-hour Win C.A.S.LLE. III
workshop presented to the National Park Service personnel at Grand Teton NP.

e Version 0.59 released on May 25, 2008.

— Added automatic check of web to see if an upgrade is available when Win
C.A.S.LLE. IIT loads.



— Added the file InitialNote.pdf to the Access Forms documents, which shows up
under the title “Using The Initial Note”.
The members of the Arizona Pima County Sheriff’s Department Search and Res-
cue Unit routinely open an Initial Note in Win C.A.S.I.LE. IIT on all lost person
cases. After examining these notes, a suggested template for using the Initial
Note emerged. InitialNote.pdf show this template, and then gives an example of
its use.

The following additions to Win C.A.S.I.LE. III are a consequence of examining the
PCSD SAR Unit’s notes.

— Under System added the menu item Military Time which toggles the format of
the time between a 12-hour and a 24-hour clock.

— Added automatic saving of the status of Auto Save and Military Time.
— Initial Note/Editor Additions

* Under Tools added the menu item Spell Check, which checks the spelling in
the current document.

* Under Tools, Insert added the menu item Initial Note which puts the words
“Initial Note” at the position of the cursor.

« Under Tools, Insert added the menu item Dispatch Call/Initial Report inserts
a list of items, such as “Informant”, “Contact Information”, and “Details”
at the position of the cursor.

x Added various items, such as “Weather Forecast”, “Case #”, “Photo”, to
existing inserts.

— Updated the Win C.A.S.I.E. IIT manual and Help files to reflect all these changes.

e Version 0.58 released on April 29, 2008.

Important: Please do not use Check For Updates under the Help menu in Win
C.A.S.I.LE. III to download this version. It will not work because I've had to move the
location of the file “InstallWC3.zip”. Go to http://wcasie.com/download.aspx and
download it from there. Once version 0.58 is installed, you can continue to use Check
For Updates. T am sorry for the inconvenience, but the original location gives various
error messages that the URL provider has not been able to resolve.

— Consensus Additons/Changes
* When starting a new search, an extra consensus option is available in addition
to Mattson and O’Connor, namely, a modified Proportional Consensus.

x Under Initial Resources — Access Forms — Consensus Form, added the
ability to print Mattson, O’Connor, and Proportional forms separately, in
addition to the composite form, where all three are printed together.

— ICS Additions
x In the Initial Note and the Editor, added the menu item ICS. This allows

users of the Australian, Canadian, New Zealand, and USA Incident Com-
mand Systems (ICS) to add their ICS titles to a note.
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Under Initial Resources added the menu item FEdit ICS Titles File. This
allows the menu items under ICS in the Initial Note or Editor, mentioned
in the previous bullet, to be customized for local use.

Magnifier Addition

Under Help added the menu item Magnifier. Clicking on this item opens
a window in which the text under the cursor is magnified. This might be
useful when projecting Win C.A.S.I.E. III onto a screen in a large room,
where some in the audience have difficulty reading the text directly from
Win C.A.S.LLE. III.

Initial Note/Editor Addition

Pressing the key combination “CTRL +” increases the font size in the Initial
Note’s/Editor’s text. “CTRL —” decreases the font size, and “CTRL x”
returns the font to its default size. This might be useful when projecting
Win C.A.S.I.LE. IIT onto a screen in a large room, where some in the audience
have difficulty reading the Initial Note’s/Editor’s text directly from Win
C.A.S.IE. III.

Problems Fixed

Fixed a problem caused by importing forms with filenames less than 7 char-
acters long.

Fixed a problem when using the Cancel key while editing the Resource file.

— Other Changes

*

Changed all the Help commands so that the Win C.A.S.I.LE. IIT window and
the Help window can be open at the same time, allowing a user to switch
back and forth between them.

Added another feature. If any of the Audit panels are open on the main-
screen, double-clicking on a non-“Saved Note” line displays the line under it
in full. As before, double-clicking on a “Saved Note” line opens the associated
document in the editor.

Made sure that the Add Resource and ICS menu items in the Initial Note
and the Editor are updated immediately once the Resource file and ICS files
are edited.

When Adding A Completed Search, if coverage is used rather than POD, the
coverage input is restricted to less than 5, which is a POD of about 99%.
Made sure that certain menu items under Initial Resources (namely, Import
External Forms, Edit Resource File, Edit ICS Titles File) are unavailable if
the application folder cannot been written to.

Under Help — History Of Changes changed the program so that this file is
read locally rather than from the web.

— Win C.A.S.LE. III Manual Additions/Changes

*

Added an additional chapter (Chapter 4: The Main Screen) and associated
exercises to the Win C.A.S.L.LE. III manual.



* Added an additional chapter (Chapter 8: Review FEzercises) to the Win
C.A.S.ILE. IIT manual. It lists a series of exercises taken from the Exercises
at the end of previous chapters. These exercises are selected so that users can
decide whether they have a good understanding of the mechanics of running

Win C.A.S.LLE. III.

* Added an additional appendix (Appendix C) to the Win C.A.S.I.E. Il man-
ual, which explains the theory behind the Proportional Consensus calcula-
tions.

x Updated the Win C.A.S.I.LE. III manual and Help files to reflect all these
changes.

e Version 0.57 released on March 23, 2008. These changes are a result of the suggestions
made by the 40 participants attending the Search Management course given at Zion
National Park by Ken Phillips (Grand Canyon NP), Bill Vandergraff (Grand Canyon
NP), and David Lovelock, and coordinated by Kevin Killian (Zion NP). March 3-7,
2008.

— Fixed a problem that laptops with very small screensizes experienced when view-
ing the Urgency Rating Chart under the Initial Resources menu.

— Clarified the message shown when attempting to close the Note Taker after
changes had been made but not saved.

— Fixed a bug in the error checking routine of the Mattson Consensus.
— Fixed typos in Exercise.pdf.

— When the Update Search menu item Remove/Edit Completed Search Assignment
is selected, renamed the button to reflect that editing, as well as removing, is an
option.

— Made various cosmetic changes.
e Version 0.56 released on February 25, 2008.

— Fixed a bug, introduced in Version 0.55, in the Save option under Resource
Allocation Advice.

e Version 0.55 released on February 14, 2008.

— Under File menu added:
x Ezxport Initial Note, which allows you to export the Initial Note to a thumb-
drive, say.
x Import Initial Note, which allows you to import an Initial Note from a thumb-
drive, say.
— Under Update Search menu added:
x Weather, which opens a new note and allows you to enter the current weather.

— In the Initial Note and Note Taker added the menu item Weather, which allows
you to enter the current weather.



— In the Initial Note and Note Taker under the menu item File added the menu
item Auto Save, which gives you the option to automatically save the note every
1, 5, or 10 minutes.

— In the Add Completed Search Assignment added the ability to reuse the input
already entered. For example, if a helicopter searches multiple segments in the
same operational period with the same POD, then you can reuse the inputs from
one segment to the next.

— If the program finds an Initial Note on the Desktop, you are alerted to this, and
various options are suggested. This is useful if a new search is about to begin,
but an Initial Note from an old search is still on the Desktop.

— Corrected a bug if PDF documents were not associated (in Windows) with a
PDF reader, such as Adobe Acrobat Reader.

Corrected typos and formatting in some LPB files. This showed up when im-
porting these files into a Note.

— Corrected cosmetic details in the Add Clue window.

— Corrected cosmetic details in the Reports.

— Updated Ezercise.pdyf.

Updated and corrected typos in the Help and the Manual.

e Version 0.54 released on June 28, 2007.

Under File menu added:

* FExport, which allows you to export the incident to a thumbdrive, say.
x Import, which allows you to import an incident from a thumbdrive, say.
% Path, which shows you the path to the current incident. (Useful if you want
to backup yourself.)
Under Update Search menu added:

x Save Bitmap From Clipboard, which saves a bitmap image already in the
clipboard as a bmp file in the current incident folder. A bitmap would
typically come from a mapping program, such as Terrain Navigator Pro,
which can copy the map on the screen to the clipboard, using “Ctrl-C”.

— Under Initial Resources menu added:

* Urgency Rating Chart, which allows you to complete an Urgency Rating
Chart.

Under What If? menu added:

x Aircraft ESW Tables, which estimates the effective sweep width for aircraft
from the tables published in the International Aeronautical and Maritime
Search and Rescue (IAMSAR) Manual.

x Change Units, which allows you to convert between different units in fields
such as Area, Length, Temperature, Velocity, etc.

x Latitude and Longitude, which in turn leads to 4 other menu items:



1. Convert Coordinate Format, which allows you convert latitude and longi-
tude between three formats: degrees; degrees and minutes; and degrees,
minutes, and seconds.

2. Distance From Degrees, which allows you to estimate the distance be-
tween two locations where the latitude and longitude are given in de-
grees.

3. Distance From Degrees Minutes, which allows you to estimate the dis-
tance between two locations where the latitude and longitude are given
in degrees and minutes.

4. Distance From Degrees Minutes Seconds, allows you to estimate the dis-
tance between two locations where the latitude and longitude are given
in degrees, minutes, and seconds.

— Under Help menu added:

x Initial Search Checklist, which contains a sub menu giving direct links to the
sorts of items you typically do at the beginning of a search.

x Ongoing Search Checklist, which contains a sub menu giving direct links to
the sorts of items you typically do during a search.

— Corrected a bug if no printers are present. Corrected a bug if the root of C cannot

be written to.

e Version 0.53 released privately on June 13, 2007 for an 8-hour workshop presented to
the Pima County Sheriff’s Department SAR unit.

e Version 0.52 released on May 11, 2007.

Added the hotkey “Ctrl-A”, which immediately opens the menu item Add Com-
ment To Audit Trail.

If a new note is created, the user is now asked whether to add an incident comment
to the Audit Trail. This comment is constructed from the first 50 characters of
the note, where carriage returns are replaced with spaces. The comment is placed
immediately before the “Saved Note” entry in the Audit Trail.

For display purposes only, the POA and CPOD numbers in the Incident Status
panel are rounded to two decimal places. By double-clicking on any row, the
actual numbers (to 15 decimal places) corresponding to that segment can now be
seen.

e Version 0.51 released on April 23,2007.

Updated the Lost Person Behavior files to agree with “Managing the Lost Person
Incident”, 2nd Edition.

Corrected a bug in See Initial POAs caused by introducing the note taking ability
in version 0.50.

Corrected a bug in Import External Form.

Corrected a problem caused by round-off error.



— If a search is not in progress, added the ability to paste the results of various
calculations under What If? into the Initial Note.

e Version 0.50 released on January 26, 2007. This version is a major update and includes
a 100-page manual and a separate video tutorial.! This version incorporates a large
number of additional features most of which were introduced as the result of two
different events.

1. A very successful multi-day workshop was given in which the instructor integrated
both Win C.A.S.ILE. IIT and a draft of “Managing The Lost Person Incident”,
27d Edition. This led to suggestions that additional items be included in Win
C.A.S.LLE. III to assist in the future teaching of such workshops.

2. Shortly after attending a workshop on Win C.A.S.LLE. III, a bright-eyed and
bushy-tailed person arrived at the start of a search. He immediately fired up
Win C.A.S.LLE. III, and when the subject was found after a few hours during
the initial stages of the search, he had not used Win C.A.S.I.LE. ITI, and had no
record of the search activities. This is because Win C.A.S.I.E. III was designed
for full-scale searches, which start with taking a consensus, whereas well over 90%
of searches end during the initial stages and before a consensus is taken. This
led to the suggestion that Win C.A.S.I.LE. III be expanded to be useful in every
search, not just full-scale searches.

We have incorporated these suggestions, and more, into this version of Win C.A.S.I.E. III.
As a result, the following new menu items are available.

— Under Initial Resources
x Clircular Search Areas calculates the area between two concentric circles.
x FEdit Resource File allows you to edit the resource file, Resource.txt.
x Initial Note allows you to create a text file, using a simple built-in text
Editor, which contains information about the initial search.
— Under Update Search
Create Note allows you to create a Note using the simple built-in text Editor.
FEdit Note allows you to edit a previously created Note.
Report generates a report, automatically incorporating all the Notes.
Transfer Incident Status To Audit Trail allows you to copy the current POAs
and CPODs from the Incident Status panel to a file to be included in the
Report.
— Under What If?
x ESW From CS Or AMDR estimates Effective Sweep Width from Critical
Separation or Average Maximum Detection Range.
x Coverage And Spacing From ESW calculates either the Coverage or the
Spacing (how far apart the members of a grid-search team should be) from
the remaining one and the Effective Sweep Width.
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IBecause of the number of changes between this version and the previous one (0.45), we have changed
the version numbers from 0.4x to 0.5x.



* Spacing From Coverage/POD allows you to convert from Coverage or POD
to Spacing for a given Effective Sweep Width.

x Coverage/POD From Spacing allows you to convert from Spacing to Cover-
age or POD for a given Effective Sweep Width.

— Under Help, the menu item History Of Changes goes to the Win C.A.S.LLE. III
website and displays the History webpage.

To account for these changes the document, Exercise.pdf, was rewritten and the Help
file was updated.

After these new menu items were incorporated, Win C.A.S.L.LE. III developed a life of
its own, and it has become sufficiently complicated that we thought that a manual
and an independent video tutorial might be helpful. So we created these items also.

The Manual

The manual, WC8Manual.pdf, can be read from within Win C.A.S.I.LE. IIT under
Access Forms, or independently. Being a pdf document, it requires the Adobe Acrobat
Reader. The manual assumes that the reader is familiar with common Search and
Rescue terms, such as POA, R.O.W., POD, CPOD, and ICS. It is over 100 pages
long, with a Table of Contents and a full Index.

This manual is divided into four parts:

— Part 1, Understanding Win C.A.S.LE. III, explains every menu item in Win
C.A.S.ILE. III. Most chapters in Part I have exercises devoted to the basic usage
of Win C.A.S.I.LE. IIT with answers at the back of the manual.

— Part I, Using Win C.A.S.LLE. III, explains how to use Win C.A.S.L.E. III at the
beginning of a search and then during a full-scale search. It also gives suggestions
on how to incorporate Win C.A.S.I.E. III into a course based on “Managing The
Lost Person Incident”, 2°¢ Edition. Table-top Exercises, designed to acquaint
the user with Win C.A.S.ILE. III as used in the field, are also included in Part II,
although answers are not supplied.

— Part ITI, Appendices, covers various topics, usually of a mathematical nature.

x Appendix A gives a one page summary of all the main menu items in Win
C.AS.LE. III.
x Appendix B, describes the theory behind O’Connor’s Consensus method.

*x Appendix C explains the mathematical relationship between POD, Coverage,
and Effective Sweep Width.

x Appendix D is concerned with Win C.A.S.LLE. III, Bayes’ Theorem, and
Search and Rescue. It discusses the mathematical model used by Win
C.A.S.I.LE. III, and shows how the standard formulas used in SAR to up-
date POAs are a consequence of Bayes’” Theorem.

x Appendix E summarizes some useful formulas used in SAR.

— Part IV, Answers, References, and Indez, contains



* Short answers to the exercises in Part 1.
* The references cited in Parts I-III.
* A full index.

Video Tutorial

The video tutorial can be downloaded from www.wcasie.com. It requires a Shockwave
player. It is widely believed that over 97% of computers already have a Shockwave
player installed.

The Win C.A.S.I.LE. III tutorial consists of eight videos (with no audio), which should
be viewed in order.

Installing Win C.A.S.L.LE. III.

The Initial Resources menu.

The File menu.

The Update Search menu.

The What If? menu.

The System and Help menus.

The Note Taker.

8. A Very Simple Search.
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After you have seen the movie, you should read the book!

e Version 0.45 released on November 16, 2006. The major change is, under What If?,
Resource Allocation Advice, the inclusion of the Washburn Algorithm (generously pro-
vided by Alan Washburn) as an option in addition to the Brute Force method. This
algorithm avoids many of the limitations of the brute force method, and is a major
improvement over the current method.

e Version 0.44 released on November 3, 2006. Fixed a problem using Access Forms if
MS Word was not installed. Added ICS204B form as a PDF document.

e Version 0.43 released on October 18, 2006. There are two new menu items:

— Under Initial Resources, the new menu item Import Fxternal Files allows you to
import TXT, DOC, and PDF documents that are then available under Access
Forms.

— Under Help, the new menu item Check For Updates checks this website to see
whether you are running the latest version. If not, it offers to download it. You
must close the current version before updating.

e Version 0.42 released on October 5, 2006. Corrected a rounding error that could
influence the calculations under certain conditions. It would be prudent to discard all
incident files created under earlier versions.



e Version 0.41 released on October 2, 2006. Ability to read MSWord and Text documents
under Access Forms activated.

e Version 0.40 released on September 30, 2006.
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